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Chapter 1
Read Me First

Welcome to Lotus SmartSuite®, the millennium edition, for Windows 95,
Windows 98, and Windows NT 4 or later — the combination of
award-winning Windows applications from Lotus Development
Corporation.

How to use this book

Exploring SmartSuite presents information to help you get started with
SmartSuite® and introduces new features in each product. 

In Exploring SmartSuite, you will find the following information:

The contents of the SmartSuite package

System requirements 

Installation instructions

New features in each of the SmartSuite applications

Help getting started with SmartSuite

Internet features of SmartSuite

Note For step-by-step instructions to complete specific tasks, select the
Help menu from any SmartSuite application.

Who should read this book
All SmartSuite users should read Exploring SmartSuite. If you are using
Windows or Windows NT for the first time, you may want to read the
chapters covering basic skills in the Microsoft Windows manuals before
installing SmartSuite. Exploring SmartSuite assumes you know how to
perform basic operations in the Windows or Windows NT environments.

Conventions used in this book
Exploring SmartSuite uses the following conventions:

Note introduces additional information.

Key names appear in small capitals, for example, ENTER.
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Information that you are to type appears in a different typeface, for
example, Reduced Cost of Ownership. 

New!  in the margin indicates a feature which is new for SmartSuite, the
millennium edition.

To get started gets you to the starting point — to the dialog box,
InfoBox, or Assistant for the task you are doing. Then you can click the
Help button or press F1 to display online Help.

Steps to get going 

Listed below are the recommended steps for installing SmartSuite. The rest
of this chapter and Chapter 2 follow the sequence described below:

Check your package using the information in the next section to make
sure you received the complete SmartSuite package.

Confirm that your computer meets the system requirements for
SmartSuite using the specifications listed later in this chapter.

Install SmartSuite. You can install all the applications at once or choose
only the applications you need at this time. See Chapter 2 for 
instructions.

Register as a SmartSuite user. For more information, see “Registering as
a SmartSuite user” in Chapter 2.

When you finish these steps, you will be ready to use SmartSuite.

Checking your package
Check the contents of your SmartSuite package against the following list. If
your package is not complete, contact your computer dealer or supplier or
call Lotus® Customer Service at 1-800-343-5414 in the United States or
1-800-GO-LOTUS in Canada.

CD-ROM and disks
Your SmartSuite package contains one SmartSuite CD-ROM. For information
about receiving 3.5" diskettes, see the section about Media Exchange in the
Lotus Customer Support Guide.

New!
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Other contents
In addition to this book, your SmartSuite package contains the following:

Lotus Product Registration Card

Lotus Customer Support Guide

Getting the Most Out of LotusScript

Coupon for the LotusScript Application Developer’s Kit (see the back
cover of Getting the Most Out of LotusScript)

Warranty Registration Card for Canada (North America only)

System requirements for SmartSuite

This section describes the hardware, software, memory, and disk space
requirements for using SmartSuite on a stand-alone computer.

Hardware 
SmartSuite requires the following hardware:

An IBM® PC or compatible (486 or higher) 

A VGA or higher video adapter

A mouse or other pointing device

One CD-ROM drive or one 1.44 megabyte (MB) 3.5" disk drive

Software 
To use SmartSuite, you must have Microsoft Windows 95, Windows 98, or
Windows NT 4 or later installed on your computer. If you are installing from
a CD-ROM, you must have your CD drivers installed and running in
Microsoft Windows 95, Windows 98, or Windows NT 4 or later.

Browsers
Lotus FastSite™ requires Microsoft Internet Explorer 3.02 or later.

Memory 

Windows 95 or Windows 98
SmartSuite requires a minimum of 8MB of random access memory (RAM).
FastSite requires a minimum of 16MB of RAM. More memory is required to
run additional applications simultaneously.

Windows NT 4 or later
SmartSuite requires a minimum of 16MB of RAM. 
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Disk space 
To run SmartSuite from CD-ROM, Lotus recommends that you have 38MB
of available disk space.

To install SmartSuite, disk space requirements depend on the SmartSuite
applications and features you select. 

You need at least 103MB of available disk space to install the minimum
features of all the SmartSuite applications. To use less than 103MB of disk
space, install only the SmartSuite applications you want, or use the
Customize features option in Install to select only the features you need.
Lotus recommends that you have 153MB of available disk space for the
default installation. To install all the features, templates, sample files, and
Help, as well as to allot space for temporary files and data files, Lotus
recommends that you have 226MB of available disk space.

For more information on disk space requirements for each SmartSuite
application, start Install from the CD-ROM or Disk 1, or follow the Install
steps below:

1. Insert the CD-ROM or Disk 1 in the appropriate drive.

2. From the Windows taskbar, click on Start, and then choose Run.

3. Type x:\install (where x is the letter of your CD-ROM drive or disk drive).

4. Follow the instructions on the screen until you reach the Install Options
dialog box.

5. Choose Customize features. Then choose Manual install, and click Next.

6. In this dialog box you can select each application individually and then
click Customize to see all the specific features and their disk space
requirements.
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System requirements for IBM ViaVoice

This section describes the hardware, software, memory, and disk space
requirements for using IBM ViaVoice™ for Word Pro™ on a stand-alone
computer.

Hardware
ViaVoice for Word Pro requires the following hardware:

An IBM PC or compatible (Pentium 150 MHz with MMX or Pentium
166MHz without MMX)

A VGA adapter and monitor

A CD-ROM drive

A sound card (Creative Labs Sound Blaster 16 or 100% compatible, or
MWave)

A noise-cancelling microphone (included in the SmartSuite retail
package)

Software
To use ViaVoice, you must have Microsoft Windows 95, Windows 98, or
Windows NT 4 or later installed on your computer. You must also have the
current version of Word Pro (on enclosed CD) installed on your computer.

Memory

Windows 95
ViaVoice requires a minimum of 32MB of RAM.

Windows NT
ViaVoice requires a minimum of 48MB of RAM.

Disk space
To install ViaVoice, you need 110MB of available disk space, which includes
60MB for program files and 50MB for enrollment files.
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What to do next

Now you are ready to install SmartSuite and register as a SmartSuite user.
You can install all the applications at once or choose the applications you
need at this time. You can always run Install again to install the applications
or features you didn’t install the first time. For more information, refer to
Chapter 2.

For technical assistance, see the information on contacting Lotus Customer
Support in the Lotus Customer Support Guide.
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Chapter 2
Installing SmartSuite

The SmartSuite Install program transfers the SmartSuite files from the
CD-ROM or disks to a stand-alone computer or to a network file server. You
can install SmartSuite using the traditional installation method or using
Autorun. Install lets you install all SmartSuite applications at once or
individual applications as you need them. 

Installing from Autorun

If you are a CD-ROM user, Autorun lets you install SmartSuite or run
SmartSuite without installing all of the program files. When you put the
SmartSuite CD-ROM in the drive, Autorun automatically starts and you see
this screen:

Autorun lets you choose from the following Install options:

Select Install to choose the applications you want to install, or to
customize your Install.

Select QuickInstall to install all the applications. You can then select
default, full, or minimum Install.

If you don’t want to install SmartSuite, Autorun lets you run SmartSuite
directly from the CD-ROM without installing all of the program files.

Descriptive text 
appears here...

...when you let the 
mouse pointer hover 
over one of the options.
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Using Autorun, you can also access important and interesting information.
Autorun lets you install the additional files and programs in the Extras
directory, go to the Lotus Web site (on the Internet at http://www.lotus.com),
and read the SmartSuite README.WRI file.

To start Autorun manually 
Autorun does not automatically start if SmartSuite is already installed 
or if you have turned off the autoplay feature in Windows 95, Windows 98,
or Windows NT 4.

To start Autorun manually:

1. Insert the CD-ROM in the appropriate drive. 

2. From the Windows taskbar, click Start, and then choose Run. 

3. Type x:\autorun\autorun.EXE (where x is the letter of your CD-ROM
drive).

4. Click OK.

Running Install
When you run the Install program on a stand-alone computer or to a
network server, the Install screens lead you through the SmartSuite directory
structure so you know where your files are being placed.
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Information about installing SmartSuite on a stand-alone computer is
available online in the README.WRI file. Information about network
installations (server, distribution, and node) is available online in the
READNET.TXT file. To read or print this information, see “To install on a
stand-alone computer” or “To install on a network” later in this chapter.

To get Help while installing SmartSuite
While you’re installing SmartSuite, you can get Help about the options in
SmartSuite Install dialog boxes.

To see information, click Help.

To print any displayed Help topic, click Print.

To switch between Help and Install, press ALT+TAB.

To return to Install from Help, click the Close button or press ESC.

To install on a stand-alone computer 

To read and print the README file
1. Insert the CD-ROM or Disk 1 in the appropriate drive. 

2. From the Windows taskbar, click Start, and then choose Run.

3. If you are a CD-ROM user, type

x:\lotus\readme.WRI (where x is the letter of your CD-ROM drive) to read
about installing SmartSuite on a stand-alone computer.

If you are a disk user, type x:\readme.WRI (where x is the letter of your
disk drive).

4. Click OK.

5. To print, from the File menu, choose Print.

To start the installation procedure
To install using Autorun, click one of the Install options at the bottom of the
screen. 

To run Install from the CD-ROM without Autorun, or to install from disk,
follow these instructions:

1. Insert the CD-ROM or Disk 1 in the appropriate drive.

2. From the Windows taskbar, click Start, and then choose Run.

3. Type x:\install (where x is the letter of your CD-ROM or disk drive).

4. Click OK.

5. Follow the installation instructions on the screen.
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Choosing default, minimum, or custom Install
There are three types of Install: default, minimum, and custom.

Default Install includes the typical SmartSuite features used by most  
SmartSuite customers.

Minimum Install installs only the minimum features needed to run each
application in SmartSuite. If you are a laptop user with limited disk space,
you may want to choose minimum Install.

Note SmartMaster™ templates, graphics filters, and other important
features of the applications will not be installed during minimum Install.

Custom Install allows you to make your own decisions about disk space and
to choose the features you want, including some that are not installed with
the default Install. For example, you can choose to install the dictionary for
SmartCenter™, an equation editor or grammar checker for Word Pro, the
DocOnline manuals (for CD-ROM users), TeamConsolidate™ in 1-2-3®, and
a Notes™ Presentation library for Freelance Graphics®.

To install on a network

To install on a network file server, make sure you are logged in as the
network administrator. Click the “File server or multiple user install” check
box at the bottom of the initial Welcome screen in the Install program.

Information about installing SmartSuite on a network is available in the
Install Help screens and the READNET.TXT file. The READNET.TXT file
answers your network questions, provides troubleshooting information, and
includes information on automated Install, Uninstall, and MLC
(multi-lingual computing) Install.

To read and print the READNET file
1. Insert the CD-ROM or Disk 1 in the appropriate drive. 

2. From the Windows taskbar, click Start, and then choose Run.

3. If you are a CD-ROM user, type

x:\lotus\readnet.TXT (where x is the letter of your CD-ROM drive.

If you are a disk user, type x:\readnet.TXT (where x is the letter of your
disk drive).

4. Click OK.

5. To print, select the File menu, and then choose Print.

Note  During a network Install, you can read and print READNET.TXT by
clicking Open when the Network Administrator’s Guide dialog box appears.
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You can also use Microsoft Notepad or Microsoft WordPad to read and print
the file at any time.

If you also want to access the README.WRI file, see “To read and print the
README file” in the previous section.

For information on installing enhancements from the Extras directory, see
“Getting more with the Extras directory,” later in this chapter.

To use automated Install
Automated Install allows a network administrator to standardize the
SmartSuite installation for all users in an organization and to distribute
SmartSuite without requiring any user input. To read more about automated
Install, see the sample response file INSTSUIT.RSP, which ships with
SmartSuite. This sample file has comments about the usage and settings that
are available.

Automated Install can also be integrated with Tivoli Management
Environment and Microsoft System Management Server. These programs
allow network administrators to create installations that can be distributed to
users over the LAN or WAN without user input. For more information, see
the Lotus Web page, “Migration and Resource Kit for SmartSuite,” at
http://www.lotus.com/products/smartsuite.nsf/resourcekit.

Installing online manuals
SmartSuite includes online manuals for CD-ROM users. The manuals
include: Exploring SmartSuite, the LotusScript Programmer’s Guide, LotusScript
Language Reference, Exploring Organizer, the Organizer Print Layout Guide,
Using OAG and Organizer, and Exploring Approach.

SmartSuite also ships with Adobe Acrobat Reader 3.0, which lets CD-ROM
users view and print the manuals.

To conserve disk space, the default Install program does not install the
online manuals to your hard disk. You can view or print the online manuals
without installing them, or you can install them using custom Install.

To view the Suite DocOnline
To view the online manuals from the CD-ROM, do the following:

1. Insert the CD-ROM in the appropriate drive.

2. Open the Suite Help drawer in SmartCenter.

3. Open the DocOnline folder.

4. Choose an icon for a manual.
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Note You may also view and print the online manuals from the Windows
taskbar. The DocOnline folder is located in the Lotus SmartSuite folder.

To install the Suite DocOnline
Use custom Install to install the Suite DocOnline:

1. Insert the CD-ROM in the appropriate drive.

2. From the Windows taskbar, click Start, and then choose Run.

3. Type x:\install (where x is the letter of your CD-ROM drive).

4. Follow the instructions on the screen until you reach the Install Options
dialog box.

5. In the Install Options dialog box, select Customize features - Manual
install, then click Next.

6. Select Suite DocOnline and then click Customize. 

7. Click the Suite DocOnline tab and select the manuals you want to install.

8. Click OK.

After installation, the manual icons appear in SmartCenter in the DocOnline
folder of the Suite Help drawer. The Lotus DocOnline icons also appear on
the Start menu in the Lotus SmartSuite folder.

To use Uninstall 

The Uninstall feature lets you remove SmartSuite or selected SmartSuite
applications from your hard drive. Uninstall also removes the directory for
the applications and any references to the applications in system files.

To run Uninstall
1. From the Windows taskbar, click Start. Choose Settings, and then choose

Control Panel.

2. Double-click Add/Remove Programs.

3. From the list, select “Lotus SmartSuite.”

4. Click Add/Remove.

5. Select the applications you want to remove or select “Uninstall all of
SmartSuite.”

6. Click OK.

You can get more information about uninstalling SmartSuite on a network in
the READNET.TXT file, located in the root directory on the CD-ROM or on
Disk 1. See “To read and print the README file” earlier in this chapter.

12  Exploring SmartSuite



Registering as a SmartSuite user
If you have a modem or are connected to the Internet, you can register online
as a SmartSuite user by filling out the electronic forms that appear after you
complete installation. You can also fill out the postage-paid registration card
and return it to Lotus. To register by phone, call 1-800-346-6408 in the United
States or 1-800-GO-LOTUS in Canada. In all other countries, you should
contact the local Lotus office, whose phone number is listed in the Lotus
Customer Support Guide. 

Registered users receive the following:

Product upgrade information. When an upgrade becomes available,
registered users get information on upgrade promotions.

Replacement CD-ROM. If your distribution CD-ROM becomes
damaged, Lotus will replace it.

Getting more with the Extras directory

The Extras directory contains enhancements that you can add to SmartSuite.
Some enhancements you use directly from the CD-ROM, for example, Clip
Art, Word Pro sample code, and Year 2000 scripts. Other enhancements such
as OAG (Official Airline Guide Travel Information System) and ViaVoice,
you must install before you use them.

The way you install an enhancement varies with each enhancement. Below
are the installation procedures for two of the many exciting enhancements
that ship with SmartSuite. For a complete list of enhancements that ship with
SmartSuite, see the SmartSuite README.WRI file.

Installing OAG
1. Insert the SmartSuite CD-ROM into your CD-ROM drive.

2. From the Windows taskbar, click Start. Choose Programs, and then
choose Windows Explorer.

3. Select the CD-ROM drive letter, and double-click the Extra folder.

4. Double-click the ORGANIZE folder, and then click the OAG folder.

5. Double-click the SETUP.EXE, and follow the prompts in the Setup folder
to install OAG.
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Installing ViaVoice
1. Insert the SmartSuite CD-ROM into your CD-ROM drive.

2. From the Windows taskbar, click Start. Choose Programs, and then
choose Windows Explorer.

3. Select the CD-ROM drive letter, and double-click the Extra folder.

4. Double-click the VIAVOICE folder.

5. Double-click the SETUP.EXE, and follow the prompts in the Setup folder
to install ViaVoice.
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Chapter 3
What’s New in SmartSuite

SmartSuite is a package of software applications that helps you work
smarter, share information more efficiently, and master the Web with ease. 

SmartSuite includes the following applications:

Lotus SmartCenter, the information manager that gives you easy access
to all your work

Lotus FastSite, the document publishing tool for the Web

Lotus 1-2-3, the spreadsheet that revolutionized the world

Lotus Word Pro, the best word processor for today’s connected world

Lotus Approach®, the high-powered database the whole team can use

Lotus Freelance Graphics, the presentation graphics package for
everyday communication

Lotus Organizer®, time management for people who are going places

Lotus ScreenCam®, the show-and-tell communication tool for your
personal computer

This chapter describes new features in SmartSuite, the millennium edition, as
well as some features that were new in the previous release.

           in the margin indicates a feature that is new in SmartSuite, the
millennium edition.

SmartSuite: the big picture 

SmartSuite delivers powerful applications with features unique to each
application as well as features that are common across the suite. This section
describes the new suitewide features and how they help you.

Sharing your work: compatibility
SmartSuite lets you share files easily with team members who use Microsoft
Office, including Office 97, Corel WordPerfect Suite, or previous releases of
SmartSuite.

New!
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New, high-fidelity read and write features let you read and write Excel
and Word files, preserving formatting, formulas, dates, and print
settings.

“Sticky” file formats make it easy to send your files “round trip.” For
example, if you open a Microsoft Office file in SmartSuite, work on it,
and then save it back to Office, the file is saved with the original file
format by default.

The Menu Finder makes migrating to SmartSuite effortless. Using the
Menu Finder, you can select a command from an Excel menu and see the
equivalent 1-2-3 command. Word Pro lets you switch to a Word,
WordPerfect, or Ami Pro® menu set. 

KeyView for Lotus, the new set of SmartSuite file viewers, lets any user
view, copy, and print SmartSuite files. KeyView for Lotus is located in
the Extras directory on your SmartSuite CD-ROM.

Working the Web
SmartSuite is packed with new Internet features to help bring the Internet
into your everyday work.

Create professional-looking Web sites and publish existing files to the
Web with FastSite, the new document publisher for the Web.

Publish Web documents in either of two formats: enhanced HTML 3.2 or
high-fidelity jDoc, the new Java-based technology.

Use 1-2-3 Web tables to link live data from any Web page into 1-2-3, and
then work with that data as part of your spreadsheet.

Use new SmartCenter folders to get a wealth of information on the
Internet without leaving SmartSuite.

New!

New!

Equivalent 1-2-3 
command

New!

New!

New!

New!

New!
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Use the SmartSuite HTML 3.2 read and write enhancements to preserve
formulas, formatting, and settings when you share files via the Internet
and with Lotus eSuite Workplace™. eSuite Workplace is the new Lotus
Java-enabled productivity environment for network computing.

For more information, see “FastSite: the new document publishing tool for
the Web” later in this chapter, and Chapter 5, “Working the Web with
SmartSuite.”

Customizing SmartSuite: programmability
With SmartSuite, you can customize and extend your applications to meet
your changing business needs.

You can embed ActiveX components in 1-2-3, Word Pro, Approach, and
Freelance Graphics files.

Using LotusScript®, an object-oriented programming language, you can
build custom business solutions. LotusScript is BASIC-compatible and
lets you create scripts that automate repetitious tasks and integrate data
from other applications. 

Enhancements to LotusScript support all the new SmartSuite features.

Integrating with Notes/Domino
SmartSuite is the only office suite that is uniquely designed to take
advantage of Lotus Notes® and Lotus Domino™.

Now you can quickly open or save SmartSuite files to any Notes
database. With the enhancements to the Open and Save dialog boxes in
your SmartSuite applications, it’s just as easy to work with files on a
Lotus Notes server as it is to work with files on your hard drive.

To get started From the File menu, choose Open or Save, and then click
Lotus Notes.

Styles and 
number formats 
are preserved.

New!

New!

New!
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You can open 1-2-3 and Word Pro within Notes. For example, you can
open a 1-2-3 workbook, make changes to it, and save the workbook
without leaving Notes. You must have Notes 4.6, or later, installed.

Moving toward the year 2000
All SmartSuite applications are Year 2000-ready and meet the IBM standard.
This means that SmartSuite applications ensure a consistent interpretation of
2-digit date entries for both the 20th and 21st century.

For more information, see “Year 2000” in the online Help for any SmartSuite
application.

FastSite: the new document publishing tool for the Web
FastSite, the newest member of SmartSuite, is designed with the Internet and
intranets in mind. Created for non-technical users who want to contribute
information to the Web, FastSite lets you focus on the content of your Web
site rather than on the mechanics of Web publishing.

To get started When you start FastSite, the Choose Task pane appears.
Click the task you want to do.

Creating a site with your existing files
You can create a Web site using your existing SmartSuite or Microsoft Word
documents. There’s no need to know HTML, and since you don’t need to
reformat your files, there’s no duplication of effort.

New!

New!
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Publishing in three easy steps
You can publish a FastSite Web site to any Web server in three easy steps —
convert to Web pages, preview, and post.

Because FastSite includes a browser, you can preview your Web pages
before making them public. You can also view pages anywhere on the Web
without leaving FastSite.

Creating professional looks
FastSite comes with ready-made Web SmartMaster looks to give your site a
cohesive and professional look. These looks, which are similar to SmartSuite
SmartMaster looks, can easily be customized for your organization.

Connecting with Domino
Unlike other Web tools, FastSite is tightly integrated with Lotus Domino.
You can easily move collections of files to Domino and then incorporate the
Domino search, replication, and security capabilities.

For more information, see “Publishing made easy with FastSite” in 
Chapter 5.

What’s new in SmartCenter
SmartCenter, the SmartSuite command center, delivers quick access to the
information you use most often. SmartCenter is designed like a file cabinet,
so you can store information in customizable drawers and folders.

For more information on using SmartCenter, see Chapter 4, “Getting Started
with SmartSuite” and Chapter 5, “Working the Web with SmartSuite.”

New!

New!

New!

Click here to see 
more drawers.

SmartCenter drawers

Opened folder

Click here to open drawer.
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Maximized folders 
You can maximize your folders to the full size of your screen. In one click,
you see more detailed information, such as a full week in the Calendar
folder, detailed company information in the Stock folder, or a weather
satellite view in the Weather folder.

To get started Click the folder that you want to maximize. Then click the
Maximize button in the top right corner of the drawer.

SmartCenter and the Internet
With SmartCenter Internet folders you can monitor information such as  
news, stock prices, and weather without leaving SmartSuite.

SmartSuite Tips
You can get more out of SmartSuite using the SmartSuite Tips folder.
SmartSuite Tips is updated five times a week by the experts at PC World’s
TipWorld.com.

To get started Click the Suite Help drawer, and then click the SmartSuite
Tips folder.

Travel Reservations
You can book a flight, reserve a hotel room, rent a car — plan your whole
trip using the Travel Reservations folder.

Note Travel Reservations features may not be available in all markets.

New!

Click here to maximize.

New!

New!
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Maps
Using the SmartCenter Maps folder you can find locations around the world.
The Maps folder generates detailed maps of street locations in the United
States and regional maps for other locations around the world.

To get started Click the Addresses drawer, and then click the Maps folder.

What’s new in 1-2-3

This release of 1-2-3 provides new Internet and compatibility features, as
well as features that help you work more productively.

1-2-3 and the Internet 
You can bring data from a Web page or intranet location into a Web
table on your sheet. 1-2-3 maintains the link to the source, so you can
refresh the Web table when the data on the Web changes.

To get started From the File menu, choose Internet, and then choose
Get Data from Web.

Convert your file to HTML or jDoc and publish an entire workbook,
sheet, or range on the Web. 1-2-3 preserves the formatting from your
work.

Hyperlinking enhancements
You can assign hyperlinks to a cell, button, or picture. You can link to ranges
and objects within the same file, to another file, or to a location on the
Internet.

New!

New!

Refresh 
button

Web table

New!

New!
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Compatibility with Excel 
1-2-3 can read and write data, formulas, formatting, and print settings
from Excel versions 95 and 97. 1-2-3 can also read and write all 65,536
rows in Excel 97 spreadsheets.

Use the Microsoft Excel Menu Finder to make a smooth transition from
Excel to 1-2-3. Just enter an Excel menu command, and you see the 1-2-3
menu equivalent.

To get started From the Help menu, choose Microsoft Excel Menu
Finder.

1-2-3 has over fifty new @functions that are compatible with Excel.

Ask the Expert
Use Ask the Expert to get task-oriented Help by asking questions in your
own words. Just tell the Expert what you want to do and then select the topic
you want from a list of possible answers.

To get started From the Help menu, choose Ask the Expert or click the
Expert button in the status bar.

Drag-and-drop sheets
You can copy or move entire sheets just by dragging them within the
workbook.

AutoTotal
You can automatically sum values by typing the word “Total” or “Totals” as
a heading in your sheet — you don’t even need to click an icon.

SmartLabels
SmartLabels expand the AutoTotal feature of 1-2-3. You can automatically
create formulas by entering recognized labels such as “Average,” “Subtotal,”
or “Grand Total.”

New!

New!

New!

New!

Enter question here.

New!

New!
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1-2-3 now includes more than a dozen predefined SmartLabels. You can
customize the list of recognized terms and add your own SmartLabels using
formulas you create. You can also assign synonyms and number formats to
the SmartLabels.

Cell comments and formula markers
You can improve communication by attaching comments to any cell. Visual
markers indicate at a glance which cells contain comments. You can also
display markers on cells that have formulas to make those cells easy to find.

Print Preview enhancements
Use Dynamic Preview to check your work, make adjustments, and view
 the results before printing.

You can manipulate margins directly in the Preview window and see the
impact immediately. You can also create multiline headers and footers
and adjust them onscreen. 

You now have the flexibility to print the sheets in a workbook either on
separate pages or on the same page. You can also do this with ranges in
a collection.

Outlining
Use the 1-2-3 outlining features to collapse and expand data so you can view
and print summary data or details.

SmartLabel

Customized 
SmartLabel

New!

New!
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What’s new in Word Pro

This release of Word Pro provides new Internet capabilities, voice
recognition software, and compatibility and ease-of-use features.

Word Pro and the Internet
Use the Export Assistant to instantly convert a Word Pro document to
HTML for use on the Web. You can also automatically convert graphics
to JPEG or PNG format.

Use SmartCorrect to automatically convert URLs to hyperlinks as you
type them into your document.

ViaVoice speech recognition
Using ViaVoice, you record dictation and let Word Pro turn it into typed
text. Word Pro also converts typed text into speech. In addition, by using
voice commands, you can navigate menus without using the keyboard or a
mouse.

For directions on installing ViaVoice, see “Getting more with the Extras
directory,” in Chapter 2.

Compatibility with Word
Word Pro now works with Word 97 and previous versions of Word files.

Menu customization
Create your own personalized menu sets. You can add, delete, or
rearrange Word Pro menu items. You can also attach scripts to menu
items for even more powerful customization.

If you are familiar with Microsoft Word, Corel WordPerfect, or Ami Pro
menus, you can switch to a similar menu set while working in Word Pro.

To get started From the File menu, choose User Setup, and then choose
Menu Customization.

Header/Footer toolbar
Use the Header/Footer toolbar to create headers and footers, align their
content, and insert fields into them.

To get started Click in the header or footer area and the toolbar appears.

New!

New!

New!

New!

New!

New!

New!
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Click Here Block enhancements
With the new Click Here Block enhancements, you can:

Easily duplicate the contents of a Click Here Block in multiple places in
your document.

Use SmartCollect to define data-entry type Click Here Blocks for
building an automated SmartMaster.

Ensure that data be entered in one or more Click Here Blocks before a
document can be saved.

To get started Place the insertion point where you want the Click Here
Block. From the Create menu, choose Click Here Block.

Click Here Block Management
With Click Here Block Management you get a central location for managing
all of the existing Click Here Blocks in a document. You can change the
properties of all the Click Here Blocks, redefine the tab order, or delete
unwanted Click Here Blocks.

To get started From the Edit menu, choose Click Here Management.

Page menu
The new top-level Page menu gives you quick access to the features you use
most frequently, such as page breaks, layouts, margins, orientation, and  
numbering.

Frame, graphics, and text enhancements
Frames have been enhanced for easier manipulation. Now you get
frames with space for a caption inside or outside and big handles that
are easy to grasp.

You can also center, tile, and rotate graphics and watermarks. 

With the new text wrapping enhancements, you can make text flow
around the contour of any graphic or wrap around all sides of a frame.

In 1908, Millennia Corporation was founded to provide publishing services 
for writers around the world.  Millennia began by providing management 

and production services for publishing the printed word and thus
provided instruction and entertainment for readers of all ages.

 With the introduction of the "Information Highway,"  information is 
distributed through a variety of mediums.  Millennia Corporation

 has grown from providing publishing services and information
                    not only in the printed form, but electronically as well.                                           

New!

New!

New!

New!

New!

New!

New!

New!
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Outline Assistant
Let the Outline Assistant guide you in creating outlines. You can choose
from an expanded gallery of numbering styles or create a custom design on
the fly.

To get started From the Create menu, choose Outline.

Drop caps
You can create a drop cap in your document to highlight a letter. For
example, the classic drop cap is used in novels for “Once upon a time...”
where the point size of the letter “O” is larger than the rest of the word.

Watermarks
You can create watermarks — background graphics that you can apply to
pages, tables, table cells, frames, headers, footers, and columns. For example,
if you are working on sensitive government documents, you can display the
“Confidential” watermark on every page to remind the reader to keep the
information secure. You can also import your own pictures as watermarks.

To get started Place the insertion point where you want to create the
watermark, click the right mouse button, and then choose the related
properties option, for example Header Properties.

 What’s new in Approach

This release of Approach provides new Internet and Notes integration
features. 

Approach and the Internet
In addition to HTML, you can save Approach views and found sets as jDoc
for publishing high-quality output to the Web.

Year 2000 support
Approach, like the rest of the SmartSuite applications, meets the IBM
standard for Year 2000 compliance. This means that Approach ensures a
consistent interpretation of 2-digit date entries for both the 20th and 21st
century.

For more information, see “Year 2000” in online Help.

Integration with Notes
You can create reports and updates using Notes data with the Notes
PowerKey.

New!

New!

New!

New!
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LotusScript support 
Approach extends the power and flexibility of LotusScript with the Find and
Sort class and enhanced Help. 

IBM QMF support
You can display the results of QMFTM Queries and Procedures in Approach
forms and worksheets, and import QMF Forms to create an Approach
report.

Enhanced SQL support
Approach accesses and analyzes SQL data more quickly and with greater
flexibility than ever before.

What’s new in Freelance Graphics
This release of Freelance Graphics provides new Internet features as well as
features that let you create presentations more quickly.

Freelance Graphics and the Internet
With the Convert to Web Pages Assistant, you can convert presentations
and optimize them for fast download time. You can also run Screenshow
in a Web browser with Active X or in the Freelance Graphics Plug-In.

You can now convert your presentation graphics to JPEG or GIF format.

You can save your publishing option selections as a “style” and reuse
them in Freelance Graphics or FastSite.

To get started From the File menu, choose Internet, and then choose
Convert to Web Pages.

Hyperlinking enhancements
You can assign hyperlinks to selected text, and then link to pages within the
current presentation, to another presentation, or to a location on the Internet.

Open a blank new presentation
You can easily create a blank presentation with just a single click using the
new shortcut button on the Welcome dialog box.

Save and Go
You can now find Save and Go on the File menu. Save and Go lets you save
and compress your .PRZ file and the Mobile Screen Show Player together.

New!

New!

New!

New!

New!

New!
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Then, a colleague who doesn’t have Freelance Graphics can import and view
your presentation.

Speaker Note button
Create and edit speaker notes from the Current Page view using the
convenient new Speaker Note button.

Enhanced File Open
You can open PowerPoint and Harvard Graphics files directly without
having to open a .PRZ file first.

Compatibility enhancements
New compatibility enhancements give you improved importing and
exporting capabilities between .PRE and .PRZ files. You also get better
compatibility in chart properties and titles.

Copying pages from other presentations
You can easily copy pages from one presentation to another. The copied
pages automatically take on the look of the source presentation.

To get started From the File menu, choose Copy Pages from Other Files.

What’s new in Organizer

Organizer®, the industry’s leading time management software, offers you
two feature sets — PIM (Personal Information Manager) only or PIM with
group scheduling. 

Use group scheduling to set up group meetings, and to receive meeting
invitations, responses, and cancellations. Group scheduling lets you take
advantage of the group scheduling functionality in Lotus Notes and benefit
from Organizer’s rich PIM features and ease of use at the same time.

To use the group scheduling features, you must have Notes 4.5 or later.

Note You select the feature set you want to use during SmartSuite Install.

New!

Speaker Note

New!

New!
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Organizer and the Internet
Organizer lets you link items to files, to other Organizer items, and now to
URLs. For example, you can link a To Do item to a relevant Web page, and
then use that link to launch your browser and take you right to the URL.

Easy Clip
Easy Clip, which appears as an icon in the lower right corner of your screen,
lets you gather information from another program (such as e-mail) to quickly
create an Organizer address, appointment, task, or Notepad page.

To get started Click the Easy Clip icon.

OAG Travel Information System
The Official Airline Guide (OAG) icon lets you launch the OAG Travel
Information System, where you can book flights and make hotel and car
reservations. You can then add the trip information to your Organizer file for
easy reference. For directions on installing OAG, see “Getting more with the
Extras directory,” in Chapter 2.

To get started Click the OAG icon.

Zip2 SmartIcons
Zip2 SmartIcons® provide a direct connection to the Zip2 Maps and
Directions Web site and the Zip2 Yellow Pages Web site. Use these Web sites
to get directions, map out trips, and look for online addresses.

Multiple Calendar view
The Multiple Calendar view lets you work with your calendar and another
user’s calendar at the same time.

Note Multiple Calendar view and the following two features were in
Organizer 97 GS, which was available to SmartSuite customers at their
request.

New!

New!

New!
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Integration with PDAs 
Organizer now comes with data synchronization tools for the following
PDAs (Personal Digital Assistants): 3COM PalmPilot, the IBM WorkPad™,
and the Texas Instruments PS69xx series handheld organizers. These tools let
you send information back and forth between Lotus Organizer and your
PDAs.

vCard and vCalendar support
Organizer works with vCard and vCalendar. Support for these Internet
standards lets you drag and drop electronic business cards and events right
into your Organizer notebook without having to retype information.
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Chapter 4
Getting Started with SmartSuite

Using SuiteStart and SmartCenter, you can open your applications and work
with files quickly. Once you’ve started working, the shared design of your
SmartSuite applications helps you learn the products easily.

Starting SmartSuite products 

When you install SmartSuite, SuiteStart and SmartCenter are automatically
installed. You can start your SmartSuite applications using either SuiteStart
or SmartCenter. You can also start your SmartSuite applications using the
Windows Start menu.

SuiteStart
SuiteStart is the icon palette that appears in the bottom right corner of the
Windows taskbar. To start a SmartSuite application, click its icon in
SuiteStart.

When you let the mouse pointer hover over the icon, the application name
appears.

Note You may also see the Easy Clip icon in the bottom right corner of the
Windows taskbar. Easy Clip is an Organizer icon and is not part of
SuiteStart. It lets you move information from other applications into
Organizer.

SmartCenter
SmartCenter, with its file cabinet drawers, initially appears on the top of
your screen and looks like this: 
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You can start your SmartSuite applications using the SmartSuite drawer.

To get started Click the SmartSuite drawer, click the Lotus Applications
folder, then double-click the application icon.

Opening a file from SmartCenter
You can open a file in your application’s work directory directly from
SmartCenter. You don’t need to open the application before opening the file.

To get started Click the SmartSuite drawer, click the application folder,
and then double-click the file you want.

All the files you’ve saved to an application’s work directory automatically
appear in the corresponding SmartCenter folder. For example, the Freelance
Graphics default directory is \lotus\work\flg, and when you save a file to
this directory, the file also appears in the SmartCenter folder for Freelance
Graphics. 

Work folders
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Getting familiar with SmartSuite

SmartSuite applications share a similar design so you can concentrate on
what each application does, not on how to do it.

The SmartSuite shared design
Once you’ve learned how the menus, SmartIcons, tabs, charting, status bar,
and InfoBox work in one SmartSuite application, you can work the same
way in the rest of the applications.

The InfoBox
The InfoBox is a fast and direct way to make one or multiple changes to
SmartSuite objects.

Tabs

SmartIcons

Status bar

Menu

InfoBox

Lines & Colors tab

Click a button to 
choose the option.

Click the arrow to 
see other line 
styles.

Here is what you have selected.

Click to close.
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You can change many objects with the InfoBox, including 1-2-3 sheets,
ranges, charts, or maps; Freelance Graphics presentations, clip art, or text;
Approach tables or views; Word Pro documents, frames, tables, or text; and
much, much more.

What makes the InfoBox so useful?
The InfoBox stays open after you’ve made a change so you can easily
make multiple changes.

The InfoBox arranges the properties you can change in well organized
tabs, so you can easily find the options you want.

The InfoBox is context-sensitive. It displays different options as you
change your selection. Just click the object you want to change, for
instance, a Freelance Graphics table, and the InfoBox displays the
available options for the object you selected.

With the InfoBox, you immediately see the results of the changes you
selected. You don’t have to close the InfoBox first.

You can collapse or move the InfoBox so you can keep it open without
crowding your work.

To display and close the InfoBox
When you select the text or object you want to change, its InfoBox icon
appears. To display the InfoBox, just click the icon. You can recognize an
InfoBox icon by the small yellow diamond on a blue square:

To close the InfoBox, click the Close button in the top right corner. 

Click and drag the 
title bar to move the 
InfoBox.

Double-click the title bar to collapse or return to normal size.
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Getting the right Help at the right time

SmartSuite online assistance offers several ways to get answers to your
SmartSuite questions.

Getting task Help
Online Help for all SmartSuite applications is organized by task. The
procedures give you quick, step-by-step directions to help you complete
your tasks. 

Besides help on tasks, you can also get background information in Overview
topics and specialized information in Details topics. 
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Using the Index
When you click the Index tab in your application’s online Help, a list of
keywords appears. Enter a word or subject and, if it’s on the list, the Index
scrolls to that keyword. When you double-click the keyword, Help displays
either a Help topic or a list of topics to choose from.
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Asking the Expert
Both 1-2-3 and Word Pro have Ask the Expert. You can ask questions in your
own words without worrying about using the “right” terminology, and the
Expert points you to the answer.

To get started Choose Ask the Expert from the Help menu or click the
Expert button in the status bar.

Using other kinds of online assistance
The following online user assistance also helps you get your work done.

QuickDemos provide step-by-step demonstrations. Look for the
QuickDemo icon in the Help topics of any application to see if a demo is
available.

SmartCenter Help gives you all the information you need to use
SmartCenter and SuiteStart. You can find SmartCenter Help by clicking
the Suite Help drawer in SmartCenter, and then double-clicking the
SmartSuite Help icon in the Help folder.

Cross-application Help gives you step-by-step directions for using your
SmartSuite applications together. You can find cross-application Help by
clicking “Using SmartSuite Applications Together” in the Contents
section of SmartCenter Help.

Guide Me in Freelance Graphics asks you questions related to the task
you’re doing. These questions guide you to the appropriate Help topic.
You can find Guide Me by clicking the Guide Me button at the top right
of your Freelance Graphics presentation or by choosing Guide Me from
the Help menu.

Enter question here.
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Chapter 5
Working the Web with SmartSuite

SmartSuite brings you closer than ever to the Internet and to your company’s
intranet. With SmartSuite you can connect to a wealth of information,
publish files on the Web, and share data easily.

Getting and using the information you need

1-2-3 Web tables and SmartCenter Internet folders help you access
information on the Internet and use that information in your work.

Using Web data in 1-2-3 Web tables
1-2-3 lets you pull data from a table on the Internet into a Web table in your
1-2-3 sheet.

Once you’ve created the Web table, 1-2-3 maintains a link to the source URL
so you can refresh (update) your sheet when the data on the Web changes.
You can choose to refresh the table manually or have 1-2-3 refresh the table
at an interval that you specify.

You can use the data in your Web table to perform calculations just like any
other data in your sheet. For example, you can use the Web data in formulas,
@functions, and what-if tables.

Refresh 
button

Web table

Calculations 
using Web 
data
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Web tables help keep your spreadsheets current. For example, you can
extract stock quotes from a Web page and pull them into an investment
portfolio, bring current interest rates into a what-if table, or use budgeting
information from your organization’s intranet in a forecasting spreadsheet.

To get started From the File menu, choose Internet, and then choose “Get
Data from Web.”

Using SmartCenter to find what you need on the Internet
SmartCenter lets you monitor valuable Internet information, such as stock
quotes, weather, and current news articles, without leaving your SmartSuite
applications.

What makes SmartCenter Internet folders so useful?
SmartCenter comes with a default set of Internet folders that pull
information from trusted Web sites, such as PC Quote for monitoring
stock information or INTELLICAST for checking weather forecasts.

SmartCenter comes with its own built-in browser. You can also use
Internet Explorer (IE) 3.02, or later, if it’s installed on your computer.
This means that you don’t need to launch a separate browser to get
information from the Internet.

SmartCenter makes it easy to access the Internet without leaving your
work. With just one click on an Internet folder, you get the information
you want. With another click you return to your SmartSuite application.

SmartCenter lets you tailor the information you’re tracking to meet your
own needs. For example, you can choose what type of news articles you
want to view or what stock prices you want to check.

You can add your own Internet folders that link you to the sites you use
most often.
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If you have created your own list of favorites in IE or bookmarks in
Netscape, SmartCenter detects them and automatically puts them in the
appropriate folder.

Using maximized folders to get the most out of SmartCenter
By expanding your Internet folders to their maximum size, you can view
more Internet information and link to additional Web pages.

When you maximize an Internet folder, SmartCenter displays a split screen
with links in the left pane and a browser window in the right pane. When
you click a link on the left, you launch a Web page on the right.

Note When you maximize certain types of folders, SmartCenter displays a
single large pane.

To get started Click the folder you want to maximize, and then click the
maximize button in the top right corner of the drawer.

Finding what you need with the SmartCenter Internet folders
SmartCenter comes with the following default set of Internet folders. You
can find most of these folders in the Internet drawer.

Headlines. Keep up with the latest news, including news from the world
of business, technology, and sports.

Stock Quotes. Track your favorite stocks in the financial markets. When
you maximize this folder you also get earnings reports, company
profiles, and price charts for the companies you are monitoring.

Weather. Get information about the weather in your area or around the
world by selecting the regions and cities you are interested in. When you
maximize this folder you see a satellite view of the world.

Click a link...

Click here to maximize 
or minimize the folder.

...and the Web 
page appears here.
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Web Reference. Search the Web for sites you want or use built-in links
to a variety of topics, such as US Zip Codes.

Travel Reservations. Research and book travel plans through
Travelocity, a service of SABRE Interactive.

Favorites. If you use Microsoft Explorer, SmartCenter automatically
includes a Favorites folder with the Favorites list you created in
Explorer.

Bookmarks. If you use Netscape, SmartCenter automatically includes a
Bookmarks folder with the Bookmarks you created in Netscape.

Maps. This folder uses MapQuest’s Interactive Atlas to generate maps of
over 3 million towns, cities, and countries worldwide. You can also use it
to generate driving instructions and highlighted map routes for North
American destinations.

To get started Click the Addresses drawer, and then click the Maps
folder.

SmartSuite Tips. Get tips on using SmartSuite from the computer
experts at PC World’s TipWorld. New tips are added daily.

To get started Click the Suite Help drawer, and then click the
SmartSuite Tips folder.

You can use Internet URL folders to add Web sites to SmartCenter. You can
add new folders to any drawer.

To get started Click the drawer in which you want to add an Internet
folder, click the drawer menu button in the top left corner, choose New
Folder, and then follow the guided steps.

Publishing made easy with FastSite

FastSite, the newest member of the SmartSuite family, lets you build and
publish Web sites using existing files. With FastSite, even a novice can
quickly create professional-looking Web sites.

Start with the FastSite desktop
When you build a Web site, you generally must do the following tasks:

Create a home page and navigators

Add content

Convert your content to a format viewable on the Web

Preview your output

Post your site to a server

42  Exploring SmartSuite



FastSite lets you do all of these tasks right from the FastSite desktop. It even
creates a home page and navigators for you.

The FastSite desktop has the following panes: 

A site hierarchy pane on the left, which gives you a map of your sites.

A tabbed pane on the right for starting tasks quickly (Choose Task pane)
and for previewing your documents (Preview Web Pages pane).

The site hierarchy pane
The site hierarchy pane is a map of your sites. When you create a site, this
pane automatically shows all the items in your site and how they are linked
together. You can also edit a site by dragging and dropping items in the site
hierarchy.

The Choose Task pane
The Choose Task pane gives you a place to start. This is where you build,
convert, edit, post, and update your site.

The Preview Web Pages pane
The Preview Web Pages pane lets you preview the published pages in your
site. It also functions just like a Web browser, letting you navigate from site
to site on the Web by clicking hyperlinks.

Site hierarchy pane

Choose Task pane

Click to 
preview

Most 
common 
tasks
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Building a site
FastSite lets you create a site by adding your existing files — spreadsheets,
word processing documents, databases, and presentations — to a site
without recreating or reformatting the content. The following graphic shows
a FastSite Web site.

In addition, you can choose from many different Web SmartMaster looks to
give your site a consistent and professional appearance. These Web
SmartMaster looks provide buttons that let visitors navigate through your
site. You can also customize your look with logos, images, animation, and
text.

FastSite also lets you create sections to help you organize your site and
hyperlinks to connect it to other Web sites.

To get started  In the Choose Task pane, click “Create a site,” and then
follow the guided steps in the Create Site dialog box.

Editing a site
After you create a site, you can add more files, change publishing options,
modify the look of the entire site or a section of it, and much more.
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Publishing a site
You can publish a FastSite Web site to any server in three easy steps —
convert to Web pages, preview, and post.

Converting to Web pages
Once you have designed your Web site, you can batch convert your files to
either HTML or jDoc. This means FastSite can convert all your files to output
that is viewable on the Web. It also automatically generates a home page
with links to all of your files.

To get started In the Choose Task pane, click “Convert files to Web pages”
and then follow the steps in the Convert to Web Pages dialog box.

Previewing
You can preview your site before posting it to eliminate trial and error. You
can preview it in FastSite or in a Web browser. Because FastSite behaves like
a browser, you don’t need to switch back and forth between multiple
applications.

To get started To preview your site in FastSite, select the site in the site
hierarchy, and then click the Preview Web Pages tab. To preview your site in
a browser, click the Choose Task pane. Then click “Preview Web pages in
browser.”

Posting
You can post a site to a local drive, a network server, an Internet server, or a
Domino server.

To get started In the site hierarchy, select the site you want to post. Then
click “Post Web pages to a server” in the Choose Task pane.

Unlike other Web tools, FastSite is tightly integrated with Domino. You can
easily move collections of files to Domino and then incorporate the Domino
search, replication, and security capabilities. You don’t need a Notes client to
post FastSite sites to a Domino Web server.

Updating a site
FastSite saves you time by highlighting your out-of-date files. (Out-of-date
files no longer match their source files.) This means that when you update
your site, you only have to convert the highlighted files.

To get started In the site hierarchy, select the site you want to update. Then
select “Convert files to Web pages” in the Choose Task pane.
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Using SmartSuite tools for Web publishing

When you publish files to Web sites from your SmartSuite applications, you
use an Assistant to help you convert your files to Web pages. You can also
create hyperlinks to other locations within your current file, to other files, or
to a location on the Internet.

Converting to Web pages
1-2-3, Word Pro, Freelance Graphics, and Approach each offer you different
options when you convert your files to Web pages. Each application has an
Assistant to step you through the file conversion process.

1-2-3 users can publish a range, a sheet, or an entire workbook to the
Internet. Use jDoc, the Java-based viewing technology, to display all the
data and objects in your sheet or workbook. Use the HTML table format
to publish a range as data that can be read back in 1-2-3 or in an eSuite™
spreadsheet.

Word Pro users can export either the entire file or just the current
division. The Export Assistant lets you include headers, footers,
footnotes, and a user-defined URL. You can also save divisions and
sections as separate files. If you choose to save divisions or sections as
separate files, you can include navigation arrows and a table of contents.

Freelance Graphics users can choose to convert each presentation page
to one image for greatest fidelity, or separate the images and text on a
presentation page for faster downloading. You also have the option to
show the presentation in a Web browser using either ActiveX or a
plug-in. You can use the Web Screen Show Player — the Lotus plug-in.

Approach users can convert any Approach view.

FastSite supports each SmartSuite application’s publishing options.
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For more information on HTML and jDoc, see “Publishing high-fidelity
documents to the Web” later in this chapter.

Creating hyperlinks
You create hyperlinks in your SmartSuite applications using the Create
Hyperlink dialog box. You can link to locations and objects within the same
file, to another file, or to locations on the Internet.

In your SmartSuite applications you can do the following:

Create a hyperlink on a selected object or text to any URL.

Create, edit, and remove hyperlinks with a right-mouse click.

Change the underline and color attributes of hyperlinked text.

From the Create Hyperlink dialog box, browse for a URL on the Internet
or intranet and then paste the URL into the dialog box to create a link.

You also get the following product-specific hyperlinking capabilities:

1-2-3 lets you create hyperlinks on buttons, cells, and pictures.

Word Pro and Freelance Graphics let you create hyperlinks on text and
graphics.

Freelance Graphics lets you create hyperlinks on selected text within a
text block.

Word Pro automatically creates a hyperlink when you type in a URL.

Word Pro supports hyperlinking to Lotus Domino.

FastSite lets you link to any URL or to another document in the same
site.

To get started Select the item that you want for the source of your
hyperlink, for example text, an object, or a cell. Then choose Hyperlink from
the Create menu.

Using Word Pro as your HTML editor
When you use Word Pro as your Internet editor, you can create documents
using Internet SmartMaster templates, graphics, tables, HTML forms, and
even wallpaper backgrounds. Word Pro provides the Web Toolbar to help
you preview and publish your Internet documents. 

To get started From the File menu, choose Internet, and then choose Show
Web Tools.
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Publishing high-fidelity documents to the Web

SmartSuite offers a number of high-fidelity formats for publishing your files
to the Web, including enhanced HTML 3.2 and the new Java-based
technology, jDoc.

Publishing HTML output
With the SmartSuite enhancements to HTML 3.2, your files will not only look
better on the Web than ever before, but you will also be able to share
information more efficiently.

The 1-2-3 HTML export filter supports the following:

Tables that include formulas, number formats, and numbers that 1-2-3
and eSuite spreadsheets can read as values

Cell background colors, text attributes, row heights, column widths, and
alignment styles

The Word Pro HTML filter supports the following:

Cascading style sheets

Headers, footers, and footnotes

JPEG and PNG images

Freelance Graphics Web output supports the following:

GIF and JPEG images

Text with tiled backgrounds (to reduce download time for viewing with
a browser)

Options that let you view your output using ActiveX or a plug-in

Transparent GIFs

Publishing jDoc output
SmartSuite lets you publish high-quality documents using jDoc, the  
Java-based viewing technology from Net-It Software Corporation. You can
view your jDoc documents in any Java-enabled browser, such as Microsoft
Internet Explorer 3.02 or higher, or Netscape Explorer 3.0 or higher. 

Using jDoc, you can:

Generate WYSIWYG (What You See Is What You Get) output that
matches your file’s printed output.

jDoc output supports all of the print settings available in SmartSuite. A
jDoc document looks exactly like a printed page.

Produce high-fidelity output on the Web without any loss of formatting.
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 Sharing information using the Open/Save dialog box

Today, collaborating as a team and relying on intranets or the Internet for
sharing data is part of everyday work.

Using Open/Save from Internet, you can share documents via any Internet
server without leaving SmartSuite. The improved Open/Save dialog box
makes it easy to open or save a spreadsheet, document, or presentation
directly from and to Web and FTP servers. This means you can edit and
analyze the information and then incorporate it into your own work. Now
you can also delete a file that’s on an FTP server.

To get started  From 1-2-3, choose Open or Save from the File menu, and
then click Internet. From all other applications, choose Internet from the File
menu, and then choose either Open from Internet or Save to Internet.

Getting started on the Internet with the Setup Assistant
When you first connect to the Internet, the Internet Setup Assistant helps you
configure your Internet access. The Assistant guides you through HTTP and
FTP configuration and setup, and helps you select security options.

To get started From the File menu, choose Internet, and then choose Setup.
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